
 

bout TypeIndexer™

      TypeIndexer catalogs and samples all PostScript™ typefaces in your library. Its unique and 
outstanding feature is the ability to access an unlimited number of uninstalled fonts as well as 
installed ones. It provides a printed alphabetical list of all font [printer file] names, with line 
samples of each, at up to 60 typefaces per page (20 and 40 per page formats are also included). 
      For more detailed inspection, TypeIndexer samples 1, 2, 4, 6, and 15, fonts on a page. Also, a 
file location index shows the exact location of each printer font file. The character chart displays 
all available characters for any font, with their respective octal codes. Octal codes are included 
for programs that accept PostScript code. Octal codes are used to insert special characters not 
available using the keyboard.
      Another outstanding feature of TypeIndexer is its powerful search capability. Select an entire 
drive, and TypeIndexer will find all PostScript fonts on it. Or select a particular folder, and 
TypeIndexer will search that folder and all its sub-folders. You may also select single font files 
for random sampling using any of the “Page Templates”.
      TypeIndexer occupies less than 375K of disk space, yet it can process an unlimited number of
font files. Actual capacity depends upon the amount of RAM allocated for it in the Get Info 
dialog box. Allocating 1250K of program memory will allow processing up to 3000 font files at 
a time. The more memory allocated, the greater the number of files that can be processed.

Using TypeIndexer
System Requirements:
1)    A Macintosh computer running system 6.0.7 or higher.
2)    Any PostScript printer.

Preliminaries:
      Before using the program, it is good practice to back up the Installer archive. Files transmitted
over the Internet are usually sent in BinHex format. Since you are reading this, the original 
download will have been decoded (usually automatically) by a program like Stuffit Lite™, and 
you will have double-clicked the Installer icon to get to this file. But both the original download 
and the Installer archive are saved until you trash them. Once your backup is made, return to the 
TypeIndexer folder created on your desktop, which should have the application, templates folder,
Read Me! and (unless you have a demo) legal info in it.
      The printer selected under the Apple “Chooser” will be the working printer. If this printer is 
on, turn it off. Wait a moment, turn the printer back on and allow it to warm up. If you are 
processing more than 3000 fonts at a time, increase program memory allocation to 1500 or 2000 



in the "Get Info" box. Note: If you are running the Demo version, it is fully functional, but will 
process only 35 fonts at a time, and is limited to font names beginning with 'A' through 'H'.

Running TypeIndexer:
Double click on the TypeIndexer icon. A "pop-up" menu and four “buttons” operate the program:
the “Page Template” pop-up, the “Select...” button, the “Clear List” button, the “Print List” 
button, and the “Cancel Download” button.

The “Page Template” Pop-Up Menu
provides the various printing formats (built-in/custom) in which fonts are arranged for viewing 
on the output pages.

Built in layouts:
1)      1, 2, 4, or 6 per page
2)      15 per page TypeIndex
3)      Character Chart
-----------------------------
Custom layouts:
1 Cap Height Calculator
1 Point Rule
15 Up Plain
15 Up/Path
20 per page
40 per page
60 per page

“1 per page” (one typeface sample per page) displays the font in 48 pt. and 72 pt. type sizes. The 
“2 per page” through “6 per page” layouts allow a corresponding number of samples per page in 
progressively smaller sizes. At 15 per page, a type index displays an alphabetical list of the 
printer font files. This template gives a compact overview of a large number of fonts, and 
displays most, if not all, the characters. From its list you can choose fonts you wish to see more 
closely using other templates. The purpose of the "Character Chart" is to show all characters 
built into any particular font, whether accessible by keyboard or not.

Custom Layouts
Within the folder named "TypeIndexer Templates" are numerous text files that contain the 
PostScript programming code for the various layouts. Layouts listed below the separator line in 
the pop-up menu are located in the Templates folder. These files may be opened with any text 
editor such as Simple Text, Teach Text or BBEdit. If you are interested in hacking in PostScript, 
open the Hacker Folder and take a look at "1 Plain Text". This example contains all of the 
variables used, with examples and notes on how to create your own layouts.
Please note that technical support is not available for PostScript programming. These routines are
excluded from any technical support.
      
        Now hold the mouse down on the Page Template pop-up menu, and drag to “2 per page”.



The “Select...” Button
recognizes printer font files, folders or disks. This feature allows fonts themselves, and fonts 
within any combination of folders and drives, to be put into the scrolling list in the main window.
System 7 users may use its “drag and drop” feature to drop folders or files (or their aliases) 
directly on the TypeIndexer application icon. After a search, the list is arranged alphabetically by 
folder. Subsequent searches are appended to the end of the list in their original order. To sort the 
list alphabetically, drag down under the Options menu to “Sort”, or use the key combination 
âŒ˜S. The total number of files in the list shows just below the window.

 

      

    Now click “Select...”. A standard dialog box comes up asking you to select a disk, folder or 
file. Click on “Desktop”, and you should see the name of your Hard Disk. At this point, if you 
clicked on the Hard Disk icon, and then on “Select Hard Disk” the disk itself would be searched, 
and all PostScript fonts on the Hard Disk would be found. If you chose instead to “Open” the 
disk and select one of the folders, only that folder (and any sub-folders) would be searched. You 
may also “Open” folders until the font files themselves are accessible. If you wish to select a 
number of individual fonts, or less than all folders, do one at a time in any order desired.



      For now, open the folder named System Folder, then the Fonts sub-folder. In the displayed list
of fonts, choose one by clicking on it and then on either the “Select (name)” box below the list, 
or the “Open” button. [Note that the “Select (name)” box changes to correspond with the 
selection.] The main window reappears, and the file you selected appears in the font list window.
      Again click “Select...”. In the Fonts folder, select another font file, and the second name 
appears in the window. The “Files” box will read 2. More fonts could be added to the list at this 
point, and TypeIndexer would print all of them in the page layout selected. Remember that the 
list can be sorted alphabetically by typing âŒ˜S.

The “Print List” Button
executes the download. Now click “Print List”. The button name changes to “Pause after Page”, 
which, when clicked, pauses the printing process after the current page has printed. During this 
pause mode, the font list and layout selections may be changed.
      There are two progress bars at the top right in the main window. These bars show the progress
of each page download and each font download. “Status:” shows the state of your printer, and 
“Font” shows the file being downloaded. As the list is sent to the printer, the “Files” boxes 
become active. “This Page” shows progress on each page. “Processed” and “Remaining” show 
the total corresponding numbers. A page will soon print displaying the two fonts you selected.
      Now click “Select...” and navigate to the Fonts folder. Click, but do not open it. Instead, 
choose “Select Fonts”. Choose “4 per page” from the pop-up menu, and click “Print List”. 
Processing will begin, sampling all fonts found in the folder in a 4-up layout. Note that printed 
pages are offset for binder placement.

      Now choose “15 per page” from the pop-up menu, click “Select...” and navigate to your Hard 
Disk. For this example, “Select” the Hard Disk. TypeIndexer will search every folder on the disk,
looking for PostScript fonts. After the search is complete, type âŒ˜S to sort the list.
      Click on the “Print List” button, and the process begins of downloading each font that will be 
sampled. When a page is full, it will print showing 15 fonts in three columns. The first column is 
a list of the printer font file names, the second is a display of the screen typeface names in 9 pt. 
sampled type, and the third is a line sample in 14 pt. type. These are the largest practical sizes for
sampling 15 fonts on a letter-size sheet of paper. File and screen names can contain up to 31 
characters and should have no spaces. [Note: fonts appear to be different sizes even at a fixed,14 
pt. sample size. Actual size, spacing etc. are determined by the font foundry or manufacturer.]

The “Clear List” Button
brings up a warning box that makes sure the deletion of all items is intended. Single or multiple 
items may be deleted also. Select a single item by clicking on it. Select random items by 
âŒ˜click. Select a range of items by dragging with the pointer, or by holding the Shift key and 
selecting the first and last. Deselect single items by âŒ˜click. Deselect a range by âŒ˜drag. 
When any item is selected, “Clear List” changes to “Clear File(s)”, and clicking on it executes 
the deletion with no warning box.

The “Cancel Download” Button
aborts the entire job if it is clicked any time after it becomes active and before printing begins. 
Otherwise, it aborts the remaining portion of the job.



Paper Size
Choose either US Letter or European A4.

Multiple Copies
Enter the desired number in the “Copies” box.

File Menu:
Print File Index
Print the location index after selection and sorting are complete. Drag down under File in the 
menu bar to “Print File Index...”. The index shows the printer font name and the path to the file. 
It is alphabetized by file name and is handy for locating fonts you wish to process or install.

Export File Index
Under the File menu also, an identical index may be exported as a tab delimited text file. 
Imported into a database program, the list may be utilized in a variety of ways.

Create Master Index... 
A master index of the selected list will export a ten-field, tab delimited file containing the 
following font information: Screen Name ∆ File Name ∆ File Path ∆ Family Name ∆ Full Name 
∆ File Creator ∆ Weight ∆ Version ∆ Notice ∆ Date-Time. This is invaluable information for the 
megafont library. Imported into a database or spreadsheet, this information can be used to 
organize and search huge libraries. Used between prepress house and client, Master Index makes 
the matching of font information easy, automatic and precise.

 



ptions Menu: (Personalize your catalog)
Drag down under the Options menu to “Preferences...”. A dialog box provides Header and Footer
entries for the output pages. The header will display the text entry in 24 pt. Times-Outline 
beginning at the upper right corner. The footer will be in 9 pt. at the lower right of the page. The 
entries will be retained until they are changed. Leave a text box empty to have no tag on the 
printed page. The text boxes will also accept PostScript octal codes. For example, entering \267 
between words, inserts a • bullet.

Custom Text for Samples...
permits customization of the paragraph appearing below the samples on the 1, 2, 4, and 6 per 
page templates. You can enter one character or up to five lines, and it will be repeated in the 
output. For the default setting, leave the box empty.

Record font downloads
Checking this box produces a running file, called “TypeIndexer Log”, of all downloaded fonts. 
This three-field, tab delimited text file appears in the same folder as TypeIndexer, and can be 
used by database programs or any program that reads text. The file shows: Screen Name, File 
Name and the File Path. The advantage of this file is the tracking of font screen names. (Also, 
see Troubleshooting below.)

Use error checking
Checking this box activates PostScript error checking. This feature helps in finding and filtering 
out bad fonts or bad files. It’s a good idea to use this feature immediately to see if any files are 
causing problems. Using the “15 Up/Path” template, select batches of fonts and see if problems 
occur. If so, the program will attempt to print the file name of the    problem font, and then 
continue on to the next. It is possible that two or more fonts in a row can be bad, and will cause 
other, unpredictable errors. At other times, a problem font can cause an error to trigger in the 
next font download. If TypeIndexer stops altogether because of a bad font, it will usually be 
recorded as the last name in the TypeIndexer Log. It’s easy to find just which files are 
troublesome using the log feature and error trapping.

Custom Layout Notes
“1 Cap Height Calculator” shows the height relationship of the “X” character to various other 
key letters in a font.
“1 Point Rule”: Select any single font to get a ruler that measures in points. Printed on clear 
acetate, it makes a handy measuring tool. You can print as many rules as the number of fonts 
selected.
“15 Up Plain” is identical to “15 per page,” except that the screen font name is always in 
Helvetica, rather than the corresponding typeface. For example, this is necessary for the Symbol 
font in order to display a readable screen name.



“15 Up/Path” is “15 Up Plain” with the font file path printed beneath each third column. This is 
handy for re-locating fonts selected from various locations.
The 20, 40 and 60 per page formats are modified line samples in portrait page mode, allowing 
quicker overviews of large numbers of fonts. These are great for creating catalogs.
"1 Keyboard" layout is located in the Hacker Folder. This template works fine on most Level 2 
PostScript printers, but has minor problems on other printers.

Troubleshooting
•      On your first run through your font library, check the “Record font downloads” box under 
Preferences. If a bad font file causes TypeIndexer to stop, you can look at the log file to see 
which file caused the problem. The last file in the list will usually be the culprit.
•      TypeIndexer will print in the background, but it is not recommended. Non-conventional 
methods are used to set up communications between the printer and computer.
•        If you experience a system crash, or the “Files” box turns to a -1, try adding a little more 
program memory in the "Get Info" box.
•      Disable any screen saver before printing, preferably by turning it off as opposed to parking 
the cursor.
•      Never compress fonts. The space saved isn’t worth the problems encountered with all kinds 
of software!
•      If two or more font files are listed with the same name, then you have more than one copy of 
a particular font stored in multiple folders.
•      If a PostScript error is generated by a damaged font file, the process indicator light on the 
printer may indicate this, and no page will eject. Turn the printer off and back on again. Wait for 
warm up and try again. Click the error flag and it will disappear.
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